Fusion-io® Virtualization Reference Architecture

Deploying Server and Desktop Virtualization on Fusion ioControl® Hybrid Storage, Cisco® UCS®, and VMware®

A Principled Technologies reference architecture commissioned by Fusion-io, Inc. (Revised)
# TABLE OF CONTENTS

Table of contents ........................................................................................................... 2
Executive summary .......................................................................................................... 3
Solution considerations .................................................................................................... 4
Summary of main findings ............................................................................................... 5
Solution components ...................................................................................................... 5

- Cisco UCS ................................................................................................................. 5
- VMware vSphere 5.1 ................................................................................................. 6
- VMware Horizon View ............................................................................................... 6
- Fusion ioControl Hybrid Storage Appliance ............................................................. 7
- Cisco UCS Fusion ioDrive 2 785GB adapter and Fusion ioTurbine software .................. 9

Workloads ....................................................................................................................... 11

- Login VSI workload .................................................................................................. 11
- OLTP (DVD Store) workload description .................................................................. 12
- Exchange (Microsoft LoadGen) ............................................................................... 13

Solution architecture .................................................................................................... 14

- Setting up Fusion ioControl ..................................................................................... 15
- Provisioning storage ................................................................................................. 17
- Setting up the host network and storage adaptor .................................................... 19
- Setting up Fusion ioTurbine ..................................................................................... 24
- Virtual machine architecture .................................................................................... 29

Validation and test results ............................................................................................ 30

- Test scenario 1 – ioControl supporting all application workloads ............................. 30
- Test scenario 2 – Scaling performance with zero footprint with Cisco UCS Fusion ioDrive 2 and Fusion ioTurbine for VMware .................................................. 36
- Using the ioControl user interface .......................................................................... 41

Summing it all up .......................................................................................................... 43

Appendix A – Detailed system configuration ................................................................. 44
Appendix B – Methodology for testing infrastructure .................................................... 47
Appendix C – Methodology for additional procedures ................................................... 72
Appendix D – Detailed virtual machine configuration ................................................. 73
Appendix E – Login VSI files ....................................................................................... 74
About Principled Technologies ....................................................................................... 77
EXECUTIVE SUMMARY

Introduction

Virtualizing your x86 servers and desktops with VMware technologies has the potential to make your business more agile, efficient and profitable. Mid-size business and small-to-medium enterprises benefit most when they can host multiple, mixed workloads within a common infrastructure – compute, storage, networking and virtualization. To support this virtualized environment of multiple, mixed application workloads requires:

- Consistent, predictable performance for mission and business critical applications
- Management of resource contention amongst applications
- Responding to performance storms without impact to other applications
- Management of solution based on business priorities
- Scaling performance and capacity with no disruption to the business

Combining the Fusion ioControl Hybrid Storage Appliance and Cisco Unified Computing System™ (UCS) with VMware® virtualization technologies (vSphere® and Horizon View) can create a solution for your business that properly runs multiple virtualized applications, including business applications and virtual desktops, while delivering the consistent predictable performance needed in a cost-effective solution. In the labs at Principled Technologies, we configured the Fusion-io and Cisco UCS solution to run steady state business-critical applications, such as online transaction processing (OLTP) and Microsoft® Exchange, with a demanding VDI workload. This reference architecture shows you how to implement these Fusion-io, Cisco, and VMware components for your data center and validates how the solution performed in our testing.

We tested the reference architecture solution by running a mixed workload environment while conducting a 600-count boot storm, or influx of initiating VDI user sessions. For our testing, the measure of success depended on the responsiveness of OLTP and Exchange workloads without interruption or degradation related to I/O contention during the most demanding conditions, such as a virtual desktop boot storm.

Objective

The objective of this reference architecture (RA) is to validate and quantify the advantages and benefits of a solution based on Fusion ioControl Hybrid Storage with Cisco UCS/Nexus Switches and VMware software for a mixed workload environment.
and how to extend storage performance without increasing spindle count or data center footprint.

This RA also documents configuration best practices for the Fusion ioControl Hybrid Storage Appliance in an environment running multiple virtualized applications.

**Audience**

The intended audience of this reference architecture is IT planners and decision-makers within medium-sized businesses and small-to-medium enterprises. Solution architects and value-added resellers may also find this reference architecture useful in deciding how to plan solutions for their customers. This reference architecture is not intended to be a comprehensive guide to deployment and configuration for every component in this solution.

**SOLUTION CONSIDERATIONS**

Proper design of the solution for a mixed application VMware environment is important because the server infrastructure needs abundant resources to handle the high density VDI user count in addition to running critical workloads, such as OLTP and Exchange. Your infrastructure should be provisioned to handle steady-state performance requirements along with bursts of data traffic. The shared storage needs to support the random IOPS that result from mixed applications along with surges of I/O traffic, such as VDI boot storm and virus scans.

The solution needs to meet the following requirements:

- Guaranteed I/O resources to mission-critical applications
- Support for a high density of virtual desktops per server
- Consistent and predictable user performance even during peak application workload conditions
- Simple configuration, management
- Out of the box reporting and monitoring
- Low latency and high bandwidth for clustering, provisioning, and storage interconnect networks
SUMMARY OF MAIN FINDINGS

We discovered multiple advantages in the reference architecture solution.

- **Guaranteed I/O performance**: By implementing ioControl QoS (Quality of Service) policies in a mixed workload environment, Cisco UCS and Fusion ioControl ensured mission-critical and business-critical storage tiers received guaranteed I/O under the most demanding portions of the mixed workload test. Our OLTP and Exchange workloads remained at optimum performance, including during a 600 virtual desktop boot storm.

- **Consolidation and VM density**: The reference architecture solution delivered performance without sacrificing density, supporting a mixed back-office workload and 600 concurrent virtual desktop users without session degradation.

- **Out-of-the-box reporting and monitoring**: ioControl came equipped with easy-to-use monitoring and reporting tools useful to a system administrator.

- **Simple deployment**: We unboxed, cabled, and configured the management interface of the Fusion ioControl storage appliance in less than half an hour.

- **Performance boost**: The solution provided uninterrupted performance and response times to all workloads tested. The addition of Fusion ioTurbine software for VMware along with Fusion ioMemory within UCS added power to our OLTP workload. This resulted in a 6X OLTP workload increase without any performance degradation or increase in storage footprint.

- **Flexible scalability**: We tested with an ioControl n5-150 appliance and a single chassis of eight UCS B-Series servers. Both solution components have additional available resources to scale that do not require a redesign of the solution or of the infrastructure.

SOLUTION COMPONENTS

**Cisco UCS**

The following Cisco components were utilized:

- Cisco UCS 6200 Series Fabric Interconnects
- Cisco UCS 2200 Series Fabric Extenders
- Cisco UCS S108 Blade Server Chassis
- Cisco UCS B-series Blade Servers for applications and virtual desktop hosting
Careful planning and management are required to maintain a fully redundant network. Due to its unified fabric model, Cisco UCS is a solution that delivers automatic network failover right out of the box—you do not need to configure any hardware or software or purchase additional pieces.

You can manage your entire Cisco UCS infrastructure from anywhere with the Cisco UCS Manager software, which is a highly available, single location for systems management. UCS Manager can apply all firmware versions and updates to existing servers, new nodes, and other hardware with the click of a mouse. Cisco UCS Manager offers support for all current and previous generation UCS hardware models, including both blade and rack servers.

As your network scales out, the Cisco UCS Central software consolidates all management systems together into one dashboard. Regardless of the hardware in your UCS deployment, you can manage it the same way from one unified interface. This lets you optimize your infrastructure to match your workloads without sacrificing the management capabilities of UCS Manager or adding additional management products.

The Cisco UCS chassis contains eight half-height bays in only 6U, provides up to 160 Gbps to each chassis, and is capable of providing 80 Gbps of bandwidth to any blade. Cisco UCS allows customers to share bandwidth across the entire domain, ensuring that servers that need the bandwidth will get it without requiring switches in every chassis. The chassis requires no integrated switches, as switching is handled upstream by the redundant Fabric Interconnect modules for the entire domain.

Our configuration consisted of a Cisco UCS 5108 Blade Server Chassis, connected to a redundant pair of Fabric Interconnects, four links per fabric. This provided 40 Gbps per fabric, for a total of 80 Gbps to the chassis.

**VMware vSphere 5.1**

We used the data center virtualization software VMware vSphere 5.1 in our testing—the latest version of the application. VMware vSphere can virtualize CPU, RAM, hard disk, and network resources for fully functional virtual desktops that can run insulated and condensed operating systems and applications. The high-availability features of VMware vSphere coupled with VMware Distributed Resources Scheduler (DRS) and vMotion can allow for migration of virtual desktops from one VMware vSphere server to another with little or no effect on end-users.

**VMware Horizon View**

VMware Horizon View is a desktop virtualization solution built on and tightly integrated with VMware vSphere. This software allows customers to extend the value of
VMware infrastructure and its enterprise-class features, such as high availability, disaster recovery, and business continuity. VMware Horizon View includes enhancements to the end-user experience and IT control. Support for VMware vSphere uses the latest functions of the leading cloud infrastructure platform for highly available, scalable, and reliable desktop services.

**Fusion ioControl Hybrid Storage Appliance**

The Fusion ioControl Hybrid Storage Appliance (see Figure 1) combines PCIe flash memory with disk. ioControl’s integrated storage QoS software allows you to provision, prioritize, and control shared storage performance.

![Fusion ioControl Hybrid Storage Appliance](image)

**Figure 1: The Fusion ioControl Hybrid Storage Appliance.**

The ioControl n5 series storage appliances are available in several base models that differ in flash and disk capacity, all of which have the ability to add additional flash and disk to scale performance and capacity independently of one another. All ioControl n5 models come with software to manage and monitor the array. Fusion-io provided an n5-150 Hybrid Storage Appliance for this RA, with the following:

- 2.4TB ioMemory flash capacity and 48TB raw disk capacity
- A wide range of software to support array specific features, including Storage QoS, Dynamic Data Placement, Phased Data Reduction, Snapshot, and Replication

For more information on Fusion ioControl Hybrid Storage Appliances, see [www.fusionio.com/products/iocontrol/](http://www.fusionio.com/products/iocontrol/).

Fusion ioControl can provision and prioritize storage resources with Quality of Service (QoS) performance policies that are grouped into three different service levels. QoS policies are assigned to each volume independently and define minimum IOPS, throughput and maximum latency for each application. A QoS policy is assigned to a
volume at creation and can be changed in real time as needs change. ioControl QoS was a key advantage in the deployment of the mixed workload reference architecture.

Figure 2 provides detailed information on QoS levels for the ioControl array and Figure 3 shows a representative mixed workload environment in which guaranteed service levels have been assigned.

<table>
<thead>
<tr>
<th>Service Level</th>
<th>IOPS Target</th>
<th>Bandwidth Target (MB/sec)</th>
<th>Latency Target (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy 1</td>
<td>Mission-critical</td>
<td>75,000</td>
<td>750</td>
</tr>
<tr>
<td>Policy 2</td>
<td>Business-critical</td>
<td>30,000</td>
<td>375</td>
</tr>
<tr>
<td>Policy 3</td>
<td>Business-critical</td>
<td>15,000</td>
<td>150</td>
</tr>
<tr>
<td>Policy 4</td>
<td>Non-critical</td>
<td>7,500</td>
<td>75</td>
</tr>
<tr>
<td>Policy 5</td>
<td>Non-critical</td>
<td>1,500</td>
<td>37</td>
</tr>
</tbody>
</table>

Figure 2: ioControl QoS policy characteristics.
Data protection

According to Fusion-io, “ioControl provides a number of data protection tools built into their Hybrid Storage Appliance, such as snapshots, cloning, and asynchronous replication. ioControl snapshots allow for timely data backups and significantly reduce RPO and RTO times. In addition, ioControl asynchronous replication is a key component for data migrations and business continuity solutions. ioControl is supported with major backup and recovery products, including Veeam®. Fusion-io is a Veeam Technology Alliance Partner and ioControl has been certified with Veeam Backup and Replication.

“Veeam enables the Always-On Business™ by providing solutions that deliver Availability for the Modern Data Center™. Veeam recognizes the challenges in keeping a business up and running at all times and addresses them with solutions that provide high-speed recovery, data loss avoidance, verified protection, risk mitigation and complete visibility. Veeam Backup & Replication™ leverages technologies that enable the modern data center, including VMware vSphere, Microsoft Hyper-V, to help organizations meet recovery time and point objectives (RTPO™), save time, mitigate risks, and dramatically reduce capital and operational costs. Veeam Backup Management Suite™ provides all of the benefits and features of Veeam Backup & Replication along with advanced monitoring, reporting and capacity planning for the backup infrastructure.

“Together, Veeam and Fusion-io provide a cost-effective solution using the latest PCIe-based solid-state shared storage, backup, recovery and replication technologies for virtual workloads – guaranteeing predictable performance for business critical applications, Quality of Service (QoS) for VM datastores and faster backup and recovery times.”

For more information, visit go.veeam.com/fusion-and-veeam.html.

Cisco UCS Fusion ioDrive2 785GB adapter and Fusion ioTurbine software

Combining Fusion ioTurbine intelligent caching software with Fusion ioMemory on a UCS B-series Blade Server provided a performance extension to ioControl without increasing the datacenter footprint. This extension complements ioControl shared storage performance by applying a low latency, high-performance, high-capacity read-cache to Cisco UCS blade servers to immediately improve performance and relieve I/O.

---

1 ioControl SPX combines ioControl Hybrid Storage, ioTurbine for VMware, and ioMemory into a single solution sold and supported by Fusion-io under a single part number. See www.fusionio.com/data-sheets/iocontrol-n5-sp

---

Fusion-io Virtualization Reference Architecture: Deploying Server and Desktop Virtualization on Fusion ioControl Hybrid Storage, Cisco UCS, and VMware
bottlenecks to the most performance intensive application in the mixed workload. This is an optional component that we chose to test as part of this reference architecture.

**Storage management with ioControl vCenter plug-in**

A plug-in is available with ioControl that allows VMware vCenter to manage ioControl. According to Fusion-io, the ioControl vCenter plug-in “simplifies the provisioning and management of Fusion ioControl shared storage.” For an image of the user interface, see Figure 4 below.

![Image of ioControl vCenter plug-in](image.png)

*Figure 4: Storage management with the ioControl vCenter plug-in.*
WORKLOADS

For the first test, we set up a mixed workload consisting of common virtualized business applications and VDI to run in concert over a 90-minute period. We ran OLTP (SQL) and Microsoft LoadGen (Exchange) in a steady state condition and then kicked off a 600 virtual desktop boot storm. After the 600 virtual desktops reached an idle state we started the VDI workload.

For the second test, we configured ioTurbine intelligent caching software with a Cisco UCS Fusion ioDrive2 mezzanine card to cache the SQL database volumes and repeated the first test with a heavy OLTP workload. Specific parameters for each workload are as follows:

**Login VSI workload**

We used Login VSI to measure the Fusion ioControl and Cisco UCS common virtualized business applications and VDI workload capabilities. The Medium workload is the standard workload on the Login VSI v4 benchmark; it simulates a typical business user’s work behavior by using productivity-related applications. We added users incrementally every 20 seconds until all users were logged in. Login VSI measures response time for several items, such as how long it takes to open a text file or compress a file. These response times degrade as the number of active users attach to the pool of desktops.

From the response times collected, Login VSI v4 initially calculates a system baseline called VSIBase, which determines—in milliseconds—the response time on a system while there is little to no load. The VSIBase is later used to calculate the VSIMax v4 threshold, which is the point the system under test will be considered saturated and subsequently degrade end-user performance and experience. Once this point of saturation is reached, Login VSI determines the VSIMax v4 result, which is the maximum number of active sessions on a system before saturation, degrading end-user experience. A successful test will not reach VSIMax v4.

For more information, see section 1.2.2 (Workloads: Medium workload) at www.loginvsi.com/documentation/index.php?title=All_settings.

**VM parameters**

- 24GB master desktop image
  - Virtual desktop OS: Windows 7 Enterprise edition
  - 1GB RAM
  - 1 vCPU
- Desktop application environment
  - Microsoft Office 2010
  - Internet Explorer
  - Adobe Reader
  - Adobe Flash
Fusion io Virtualization Reference Architecture: Deploying Server and Desktop Virtualization on Fusion ioControl Hybrid Storage, Cisco UCS, and VMware

A Principled Technologies reference architecture

Fusion - io Virtualization Reference Architecture:

- Java/FreeMind
- VMware View 4GB change disk
- About 10 to 15 IOPS per desktop at steady state, 100 percent concurrency
  - Number of sessions: 600
  - Launch interval: 20 seconds
  - Login VSI Workload: Medium
  - Number of launchers: 24

**Output**

- Login VSI response time, depicted in graphs \( \text{VSI}_{\text{max}} = \text{pass/fail} \)

**OLTP (DVD Store) workload description**

To simulate an OLTP workload, we used DVD Store, which is an open-source application that models an online DVD store where customers log in, search for titles, and purchase movies. Higher thread count and lower think times increase CPU utilization and IOPS. For more information on DVD Store, please see [en.community.dell.com/techcenter/extras/w/wiki/dvd-store.aspx](en.community.dell.com/techcenter/extras/w/wiki/dvd-store.aspx).

**Medium OLTP (no ioTurbine)**

**Testing parameters**

- Database size: 20 GB
- Number of databases: one per VM
- Number of threads per VM: 12
- Actual test run time: 90 minutes
- Think time: 100 milliseconds
- Warm-up time: 15 minutes
- Ramp rate: 10 milliseconds

**Additional VM parameters**

- See Figure 32 for VM parameters
- Each SQL VM was built on a single VMDK file with volume segregation
- Each SQL VM was configured as per best practices (C:\binaries, E:\SQL Database, L:\SQL Logs)
- ioTurbine was configured to utilize guest-based caching
- ioTurbine guest-based caching was applied to the E:\ drive on each of the four VMs, which contains both the 50 GB test database plus the tempdb database
- ioTurbine guest caching was not applied to the SQL .ldf files in the L:\ drive

**Output**

- Orders per minute (OPM)

**Heavy OLTP (with ioTurbine)**

The medium OLTP workload was repeated with the think time reduced to 0ms.
Exchange (Microsoft LoadGen)

The Microsoft Load Generator 2010 (LoadGen) benchmark performs tasks to simulate a typical user generating mail activity on Microsoft Exchange Server 2010. We divided our users into four mailbox databases, each with 100 users, for a total of 400 users/mailboxes. We ensured that performance was within acceptable RPC average latency thresholds. For more information on Microsoft Load Generator 2010, please see www.microsoft.com/downloads/details.aspx?FamilyId=DDEC1642-F6E3-4D66-A82F-8D3062C6FA98&displaylang=en.

Parameters

- Simulation: Two days
- Time: 90-minute duration
- 100 users per database (400 total)
- Client: Outlook 2007 Online
- Action profile: Outlook_200
- Mailbox profile: 100 MB

VM parameters

- See Figure 32 for VM parameters

Output

- RPC latency

---

2 Microsoft states that successful testing requires RPC latency to remain below 50 ms. For more information, see technet.microsoft.com/en-us/library/bb508871(v=exchg.80).aspx.
SOLUTION ARCHITECTURE

Figure 5 presents an overview of the components from our solution and how they connected to one another.

Figure 5: Overview of solution components.

We installed and configured VMware vSphere 5.1 on all eight of the servers. The three infrastructure servers were Cisco B200 M2 blades and the remaining five application servers were Cisco B200 M3 blades. In the SQL/Exchange host c1-s7, we installed one Cisco UCS Fusion ioDrive2 mezzanine card. Figure 6 details configuration for each server.
### Setting up Fusion ioControl

We powered on ioControl and connected a notebook to the management network interface on storage processor A. The factory default address is 192.168.100.100/24. After logging on, we edited the iSCSI and management addresses. Figure 7 shows the ioControl user interface (UI) as we configured network information.
Figure 7: Locating system network interface and addresses with the ioControl UI.
Figure 8 shows where the specific network configuration occurs in the ioControl User Interface.

![Edit Network Interface Configuration](image)

Figure 8: Editing network interface configuration with ioControl UI.

We then connected the four 10Gbps links to our Cisco Nexus 5010 Switches and two 1Gbps RJ-45 uplinks to our management network.

**Provisioning storage**

ioControl hosted all workload VM datastores and we sized each virtual desktop LUN as per VMware best practices.3 We started by classifying our applications as Mission-Critical, Business-Critical and Non-Critical based on ioControl QoS guaranteed minimum IOPS, throughput, and not-to-exceed latency policy values. Based on a typical mixed-workload business infrastructure, we assigned Microsoft SQL and 150 high-end VDI users as Mission-Critical, Microsoft Exchange and 300 mid-range VDI users as Business-Critical and remaining 150 VDI users as Non-Critical. We provisioned LUNs with the ioControl GUI. See Figure 9 for detailed storage information.

---

<table>
<thead>
<tr>
<th>LUN/NAS Name</th>
<th>Size (GB)</th>
<th>Host access</th>
<th>Policy</th>
<th>Hosting role</th>
<th>Storage processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange</td>
<td>450</td>
<td>c1-s7</td>
<td>Business-critical: 30,000 IOPS, 375 MB/sec bandwidth, 20ms latency</td>
<td>LoadGen Exchange Servers</td>
<td>A</td>
</tr>
<tr>
<td>DVD-SQL</td>
<td>500</td>
<td>c1-s7</td>
<td>Mission-critical: 75,000 IOPS, 750 MB/sec bandwidth, 10ms latency</td>
<td>OLTP SQL servers</td>
<td>A</td>
</tr>
<tr>
<td>VDT-A</td>
<td>400</td>
<td>c1-s4, c1-s5, c1-s6, c1-s8</td>
<td>Mission-critical: 75,000 IOPS, 750 MB/sec bandwidth, 10ms latency</td>
<td>150 virtual desktops</td>
<td>B</td>
</tr>
<tr>
<td>VDT-B</td>
<td>400</td>
<td>c1-s4, c1-s5, c1-s6, c1-s8</td>
<td>Business-critical: 30,000 IOPS, 375MB/Sec bandwidth, 20ms latency</td>
<td>150 virtual desktops</td>
<td>B</td>
</tr>
<tr>
<td>VDT-C</td>
<td>400</td>
<td>c1-s4, c1-s5, c1-s6, c1-s8</td>
<td>Business-critical: 30,000 IOPS, 375MB/Sec bandwidth, 20ms latency</td>
<td>150 virtual desktops</td>
<td>B</td>
</tr>
<tr>
<td>VDT-D</td>
<td>400</td>
<td>c1-s4, c1-s5, c1-s6, c1-s8</td>
<td>Non-critical: 7,500 IOPS, 75MB/sec bandwidth, 100ms latency</td>
<td>150 virtual desktops</td>
<td>A</td>
</tr>
<tr>
<td>NAS01</td>
<td>1 TB</td>
<td>Infra1-3</td>
<td>N/A</td>
<td>Test harness datastore, generic NAS</td>
<td>N/A</td>
</tr>
</tbody>
</table>

*Figure 9: Detailed storage configuration.*

We configured LUNS, assigned QoS policies, and configured iSCSI access policies in the ioControl UI. Figure 10 shows LUN configuration with ioControl.

**ioControl Provision**

![Figure 10: Configuring LUNs with the ioControl UI.](image)

Figure 11 shows configured access groups with ioControl.
Fusion - io Virtualization Reference Architecture:
Deploying Server and Desktop Virtualization on Fusion ioControl Hybrid Storage, Cisco UCS, and VMware

ioControl Settings

Figure 11: Configuring storage host access groups with ioControl UI.

Figure 12: ioControl GUI: Storage host access groups

Setting up the host network and storage adaptor

Each Cisco UCS B200 M3 server has two 20Gbps vNICs; one 20Gbps link is on Fabric A and the other is connected to Fabric B. We set up a VMware VMKernel interface on each fabric to ensure redundancy and multipathing across both fabrics. To accomplish this, we needed to specify the override vSwitch setting and specifically bind iSCSI-a to vNIC0, and iSCSI-B to vNIC1. We set up Jumbo frames on both vNICs and
tested connectivity. Figure 13 shows how we accessed the VMware host network configuration with the UI.

**Figure 13: Configuring VMware host network.**

Figures 14 and 15 show where we configured the iSCSI settings.

**Figure 14: Configuring iSCSI-a with the VMKernel interface.**
Figure 15: Configuring iSCSI-b with the VMKernel interface.

Figure 16 and 17 show where to override NIC teaming for iSCSI-a and iSCSI-b.

Figure 16: Overriding NIC teaming for iSCSI-a.
A Principled Technologies reference architecture

Fusion io Virtualization Reference Architecture: Deploying Server and Desktop Virtualization on Fusion ioControl Hybrid Storage, Cisco UCS, and VMware 22
Figure 19 shows how we discovered iSCSI targets with the host iSCSI Initiator.

Each LUN was attached to VMWare hosts. We changed the default path selection from default fixed to round robin, enabling all four 10Gbps interfaces on the array to be utilized. Figure 20 shows where to manage the paths in host datastore properties with the VMKernel interface.
Figure 21 shows where to select the path setting.

Figure 21: Selecting the multipath policy in host datastore properties.

**Setting up Fusion ioTurbine**

Fusion ioTurbine has two components: the ioSphere management appliance and a Fusion ioDrive2 mezzanine card. By using the PCI-e flash memory as a read cache, ioTurbine enabled our solution to handle large I/O demands without taxing the shared storage. The cache can be configured for the entire ESXi host or at the guest level. As Figure 22 shows, we enabled the cache at the guest level and instructed it to cache only the database volume (E:\) for each SQL server in our testing.

Figure 22: ioTurbine overview.
We installed the ioDrive2 mezzanine card into server c1-s7, which was the SQL and Exchange host. The ioTurbine management server is a virtual appliance that is deployed on an infrastructure ESXi host and managed by vCenter. The management server is deployed into the VMware environment as an OVA file. See Appendix C for deploying ioSphere.

Figure 23 shows how to register vCenter in ioSphere.

![Figure 23: Registering vCenter in ioSphere.](image)

Figure 24 shows where to find the Fusion ioSphere tab in vCenter.

![Figure 24: Locating the ioSphere tab for vCenter.](image)
Figures 25 and 26 show how we enacted a low-level format with Fusion ioSphere.

**Figure 25:** Selecting the low level reformat option in ioSphere.

**Figure 26:** Performing a low-level format.
Figures 27 and 28 show how we enabled guest-based caching.

Figure 27: Locating the cache settings in vSphere.

Select up to 8 cache devices

<table>
<thead>
<tr>
<th>Path</th>
<th>Vendor</th>
<th>Device Model</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>/vmfs/device...</td>
<td>Fusion-io</td>
<td>Block device</td>
<td>785 GB</td>
</tr>
<tr>
<td>/vmfs/device...</td>
<td>DCC</td>
<td>LUNZ</td>
<td>0 GB</td>
</tr>
<tr>
<td>/vmfs/device...</td>
<td>LSI</td>
<td>MR5A5R6E4-4I</td>
<td>298.99 GB</td>
</tr>
<tr>
<td>/vmfs/device...</td>
<td>DCC</td>
<td>VRAID</td>
<td>107.37 GB</td>
</tr>
<tr>
<td>/vmfs/device...</td>
<td>NextGen</td>
<td>TheStore</td>
<td>483.18 GB</td>
</tr>
</tbody>
</table>

Total Capacity: 785 GB
Number of cache devices: 1

Select VMs to cache:
- Cache all VMs using host-based caching
- Set custom cache settings

Figure 28: Choosing the correct options to enable guest-based caching.

Figure 29 shows where we entered guest credentials. This action is required to enable guest-based caching.
Figure 29: Entering guest credentials to enable guest-based caching in ioSphere.

Figure 30 shows where to change cache settings.

Figure 31 shows how we changed the cache volume.
Virtual machine architecture

We installed all of our VMs on a flat network. We installed all of our infrastructure VMs on generic NAS and they were hosted on a separate infrastructure server. Figure 32 shows detailed information of the VMs.
VALIDATION AND TEST RESULTS

Test scenario 1 – ioControl supporting all application workloads

- SQL/OLTP: Medium—about 6,500 OPM
- LoadGen/Exchange profile: Outlook_200
- VDI: 600 users, boot storm and Login VSI Medium workload (with flash), benchmark mode

Test scenario 1 showed that the four VDI servers and one ESXi server hosting OLTP and Exchange workloads pushed I/O requirements to burst over 20,000 IOPS and sustained a peak of over 6,000 IOPS. Storage response time remained low in spite of the demand placed on the array by the UCS Blade Intel E5-2690 processors. There was no I/O contention detected between the three workloads as VSImax was not reached on the virtual desktop workload, RPC latency was low on the Exchange workload, and operations per minute (OPM) was consistent for our SQL workload. Figure 34 shows the system total for read/write IOPS.

![System total: Read/write IOPS (IO/sec)](image)

Figure 33: Test scenario 1: I/O footprint. The boot storm completed in about five minutes.

Figure 34 shows the system total read/write response time.
A Principled Technologies reference architecture
Deploying Server and Desktop Virtualization on Fusion ioControl Hybrid Storage, Cisco UCS, and VMware

Figure 34: In test scenario 1, I/O response time remained low through all phases of testing.

Figure 35 shows the overall average OPM. The SQL server was not in contention for I/O and OPM remained flat throughout all testing.

Figure 35: Test scenario 1: OLTP OPM.

Figure 36 shows the average Exchange RPC latency. At no point in testing did RPC latency reflect I/O contention. Note: Microsoft guidance states that anything less than 50ms is acceptable RPC latency.
Looking at IOPS and response time from within the ioControl interface shows the additional IOPS being generated during VDI boot storm and the ability of the ioControl QoS engine to manage I/O prioritization for all three service levels. Figure 37 shows the IOPS and Figure 38 shows the associated response times.
Figure 37: ioControl interface showing IOPS generated during testing.
Figure 38: ioControl interface showing response times during testing.
Figure 39 shows Login VSI v4 output. At 600 users, VSI\textsubscript{max} was not reached. The increase in response times was due to processor saturation. Figure 40 shows processor utilization on host c1-s4 throughout the testing.

**Figure 39:** Test scenario 1: Login VSI v4 output.

**Figure 40:** C1-S4 VDI processor utilization throughout the test.
Summary of test scenario 1
As evidenced by the test results outlined above, in spite of a heavy mixed workload that taxed our infrastructure, ioControl demonstrated its ability to support multiple high performance applications by utilizing real time data placement along with QoS policies to guarantee predictable performance levels.

Test scenario 2 – Scaling performance with zero footprint with Cisco UCS Fusion ioDrive 2 and Fusion ioTurbine for VMware

- SQL/OLTP: Heavy—35,000 to 40,000 OPM
- LoadGen/Exchange profile: Outlook_200
- VDI: 600 users, boot storm and login VSI medium workload (with flash), benchmark mode
- ioTurbine: Guest-based cache enabled

Test scenario 2 showed that, similar to test scenario 1, the four VDI servers and one ESXi server hosting OLTP and Exchange workloads pushed I/O requirements to burst over 20,000 IOPS and pushed a sustained peak of over 7,000 IOPS. The difference in this test came when ioTurbine was enabled and serviced about 10,000 IOPS on average, with bursts into the 15,000 IOPS range and allowing for an increase of 40,000 OPM. Storage response time again remained low. There was no I/O contention detected between the three workloads as VSImax was not reached on the virtual desktop workload. RPC latency was low on the Exchange workload and OPM was consistent for our SQL workload. Figure 41 shows the system total read/write IOPS for test scenario 2.
A Principled Technologies reference architecture

Fusion io Virtualization Reference Architecture:
Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware

Figure 41: Test scenario 2: I/O footprint. The boot storm completed in about five minutes.

Figure 42 shows the read cache serviced as many as 17,000 read operations per second (OPS).

Figure 42: Test scenario 2: ioTurbine.

Figure 43 shows the system total read/write response time for test scenario 2.
A Principled Technologies reference architecture

Deploying Server and Desktop Virtualization on
Fusion ioControl Hybrid Storage, Cisco UCS, and VMware

Figure 43: Test scenario 2: I/O footprint. The boot storm completed in about five minutes.

Figure 44 shows the OPM overall average in test scenario 2. The SQL workload was not in contention for I/O and OPM remained flat throughout all testing.

Figure 44: Test scenario 2: OLTP OPM.

Figure 45 shows the average Exchange RPC latency in test scenario 2. At no point in testing did RPC latency reflect I/O contention. Note: Microsoft guidance states that anything less than 50ms is acceptable RPC latency.
Figure 45: Test scenario 2: LoadGen RPC latency.

Looking at IOPS from within the ioControl interface shows only a minor increase in Mission Critical IOPS serviced by ioControl, in addition to again demonstrating the IO prioritization managed by the ioControl QoS engine (see Figure 46).
Figure 46: ioControl interface showing IOPS generated during testing.
Figure 47 shows the Login VSI v4 output. At 600 users, VSImax was not reached. The increase in response times was due to processor saturation.

![Login VSI v4 output](image)

**Summary of test scenario 2**

As can be seen from the test results, utilizing the ioDrive2 and ioTurbine software along with Fusion ioControl increased application performance while adding no additional footprint to the reference architecture. This resulted in a SQL OPM increase over six times the OPM from test scenario 1 with no performance degradation, while at the same time resulting in only a small increase in ioControl Mission-critical array IOPS.

**Using the ioControl user interface**

The ioControl UI let us view and record both real time and historical statistics on the ioControl appliance throughout all testing. We could view statistics as they pertain to QoS policy, storage processor, or the latency on SAS disk drives versus flash memory. Figure 48 shows the main dashboard, which provides an overview of the state of the appliance, and Figure 49 provides a view into the monitoring interface.
Figure 48: The ioControl Dashboard.

Figure 49: ioControl Monitoring.
SUMMING IT ALL UP

In our testing, Fusion ioControl, Cisco UCS, and VMware technologies created a high-performance, easy-to-configure and manage solution that could handle a demanding mixed application environment consisting of common virtualized business applications and VDI. By prioritizing performance resources with ioControl QoS service levels and policies, we demonstrated that mission-critical and business-critical applications will run at optimum performance levels in a 600 virtual desktop boot storm, or an OLTP heavy-workload use case. By adding Fusion ioTurbine software and Cisco Fusion ioDrive2 into the UCS Blade Server, we further extended OLTP performance with no additional solution footprint. With the Fusion ioControl UI and ioSphere UI integration with vCenter Server, you can manage all aspects of storage, both ioControl and UCS-side Fusion ioDrive flash, from within vCenter console. Fusion ioControl Hybrid Storage and Cisco UCS is a strong solution to meet today’s demanding mixed workloads in your VMware virtualized data center.
APPENDIX A – DETAILED SYSTEM CONFIGURATION

Figure 50 shows the detailed information of the servers we used in testing.

<table>
<thead>
<tr>
<th>System</th>
<th>Cisco UCS B200 M3 server</th>
<th>Cisco UCS B200 M2 server</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>OS Control</td>
<td>OS Control</td>
</tr>
<tr>
<td><strong>CPUs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Xeon</td>
<td>Xeon</td>
</tr>
<tr>
<td>Model number</td>
<td>E5-2690</td>
<td>X5670</td>
</tr>
<tr>
<td>Stepping</td>
<td>6</td>
<td>CO</td>
</tr>
<tr>
<td>Socket type</td>
<td>LGA2011</td>
<td>LGA 1366</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.90</td>
<td>2.93</td>
</tr>
<tr>
<td>Bus frequency</td>
<td>8.0 GT/s</td>
<td>6.4</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>256 KB (per core)</td>
<td>256 KB (per core)</td>
</tr>
<tr>
<td>L3 cache</td>
<td>20 MB</td>
<td>12 MB</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Cisco UCS B200 M3</td>
<td>Cisco UCS B200 M2 Blade Server</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>Cisco FCH153271DA</td>
<td>N20-B6625-1</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Cisco B200M3.2.1.1a.0.121720121447</td>
<td>Cisco S5500.2.1.1.0.1005201213338</td>
</tr>
<tr>
<td>BIOS settings</td>
<td>Default</td>
<td>Default</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total RAM in system (GB)</td>
<td>256</td>
<td>96</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Samsung M393B2G70BH0-YK0</td>
<td>Samsung M393B5170FH0-YH9</td>
</tr>
<tr>
<td>Type</td>
<td>PC3L-12800R</td>
<td>DDR3 PC3-10600</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,600</td>
<td>1,333</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>1,333</td>
<td>1,333</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>16</td>
<td>8</td>
</tr>
<tr>
<td>Number of RAM module(s)</td>
<td>16</td>
<td>12</td>
</tr>
<tr>
<td>Chip organization</td>
<td>Double-sided</td>
<td>Double-sided</td>
</tr>
<tr>
<td>Rank</td>
<td>Dual</td>
<td>Dual</td>
</tr>
<tr>
<td><strong>Hard disk</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Seagate ST9146803SS</td>
<td>Seagate ST9146803SS</td>
</tr>
<tr>
<td>Number of disks in system</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>146</td>
<td>146</td>
</tr>
<tr>
<td>RPM</td>
<td>15,000</td>
<td>10,000</td>
</tr>
<tr>
<td>Type</td>
<td>SAS</td>
<td>SAS</td>
</tr>
</tbody>
</table>
Figure 50: Detailed configuration information for the servers.

Figure 51 shows detailed information for the storage we used in testing.

<table>
<thead>
<tr>
<th>Storage array</th>
<th>Fusion ioControl n5-150 array</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware revision</td>
<td>Fusion-io n5-150</td>
</tr>
<tr>
<td>Model</td>
<td>XN50-2448-11E</td>
</tr>
<tr>
<td>Part Number</td>
<td>2400 GB</td>
</tr>
<tr>
<td>ioMemory Capacity</td>
<td>48 GB</td>
</tr>
<tr>
<td>Storage Processors</td>
<td>Dual Active-Active</td>
</tr>
<tr>
<td>RAM</td>
<td>Data (4) 10GbE + (8) 1 GbE, Management : (4) 1GbE</td>
</tr>
<tr>
<td>Network Interfaces</td>
<td>iSCSI</td>
</tr>
<tr>
<td>Storage Protocol</td>
<td>HTTP</td>
</tr>
<tr>
<td>Management</td>
<td>Power</td>
</tr>
<tr>
<td>Dimensions</td>
<td>11.5 AMP</td>
</tr>
<tr>
<td>Dimensions</td>
<td>5.2” × 17.2” × 25.5”</td>
</tr>
<tr>
<td>Weight</td>
<td>75 lbs</td>
</tr>
<tr>
<td>Tray 1</td>
<td>16</td>
</tr>
<tr>
<td>Number of disks</td>
<td>Toshiba MG03SCA300</td>
</tr>
<tr>
<td>Disk vendor and model number</td>
<td>3 TB</td>
</tr>
<tr>
<td>Disk size (GB)</td>
<td>64</td>
</tr>
<tr>
<td>Disk buffer size (MB)</td>
<td>7200</td>
</tr>
<tr>
<td>Disk RPM</td>
<td>SAS-2, 6 Gbps</td>
</tr>
<tr>
<td>Disk type</td>
<td>Firmware revision</td>
</tr>
<tr>
<td>Storage array</td>
<td>Fusion ioControl n5-150 array</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>PCIe card</td>
<td>ioDrive II</td>
</tr>
<tr>
<td>Model</td>
<td>Fusion ioDrive II</td>
</tr>
<tr>
<td>Interface</td>
<td>PCIe</td>
</tr>
</tbody>
</table>

Figure 51: Detailed configuration information for the storage array.
APPENDIX B – METHODOLOGY FOR TESTING INFRASTRUCTURE

We prepared our UCS manager, servers, and server adaptors with firmware version 2.2(1b) and deployed all blades with Cisco UCS service profiles. We configured each profile with one vNIC per fabric, and Raid 1 for local disk policy. We installed ESXi 5.1 on each of the three infrastructure servers and the five servers under test.

Installing VMware ESXi 5.1 on the infrastructure servers and servers under test

1. Attach to the UCS server via KVM and attach the installation media.
2. Boot the server.
3. At the VMware Installer screen, press Enter.
4. At the EULA screen, press F11 to Accept and Continue.
5. Under Storage Devices, select the appropriate virtual disk, and press Enter.
6. Select US as the keyboard layout, and press Enter.
7. Enter the root password twice, and press Enter.
8. Press F11 to start installation.
9. After the server reboots, press F2 and enter root credentials.
11. Select the appropriate network adapter, and select OK.
12. Log in to the server using the VMware vSphere client.
13. Select the Configuration tab, and click Networking.
14. Click Add Networking...
15. Create the management network on VLAN 10.
16. Click on the Configuration tab, and select Time configuration to configure server time.
17. Click DNS and Routing, and confirm the settings.

Setting up a VM to host the Microsoft Windows Active Directory® server (DC1)

1. Connect to the infra1 server via the VMware vSphere client.
2. Log in as root
3. In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
4. Choose Custom, and click Next.
5. Assign the name DC1 to the virtual machine, and click Next.
6. Select infra1 as the host, and click Next.
7. Select the appropriate storage, and click Next.
9. Choose Windows, choose Microsoft Windows Server® 2008 R2 (64-bit), and click Next.
10. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
11. Choose 4 GB RAM, and click Next.
12. Click 1 for the number of NICS, select VMXNET3, connect to the PRIV-NET network, and click Next.
13. Leave the default virtual storage controller, and click Next.
14. Choose to create a new virtual disk, and click Next.
15. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click Next.
16. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the VM, and choose Edit Settings.
19. Click the Resources tab, and click Memory.
20. Select Reserve all guest memory, and click OK.
22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1. Open a virtual machine console on DC1.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New ➔ Apply ➔ Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to DC1, and reboot when the installation prompts you.
16. Set up networking for the data network:
   a. Click Start ➔ Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Uncheck TCP/IP (v6).
   d. Select TCP/IP (v4), and choose Properties.
   e. Set the IP address as 172.16.0.10/255.255.0.0

Installing Active Directory and DNS services on DC1

1. Click Start ➔ Run, type dcpromo, and click OK.
2. At the Active Directory Domain Services Installation Wizard welcome screen, check the Use advanced mode installation option, and click Next.
3. In the Choose a Deployment Configuration dialog box, select Create a new domain in a new forest, and click Next.
4. At the FQDN page, type domain.local, and click Next.
5. At the NetBIOS name prompt, leave the name domain, and click Next.
6. At the Forest Functionality level, select Windows Server 2008 R2, and click Next.
7. At the additional Domain Controller Options, leave DNS server selected, and click Next.
8. Assign a Directory Services Restore Mode Administrator account password, and click Next.
9. At the Summary screen, review your selections, and click Next.
10. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.
11. Click Start ➔ Run, and type dnsmgmt.msc
12. Create a reverse lookup zone for DC1.
13. Create static entries for the three infrastructure servers and the five servers under test.

Configuring the Windows time service on DC1

To ensure reliable time, we pointed our Active Directory server to a physical NTP server.

1. Open a command prompt.
2. Type the following:
   W32tm /config /syncfromflags:manual /manualpeerlist:"<ip address of a NTP server>"
   W32tm /config /reliable:yes
   W32tm /config /update
   W32tm /resync
   Net stop w32time
   Net start w32time

   **Setting up DHCP services on DC1**
   1. Click Start → Administrative Tools → Server Manager → Add Roles.
   2. Select DHCP Server, and click Next.
   3. At the Introduction to DHCP Server screen, click Next.
   4. At the Specify IPv4 DNS Settings screen, type domain.local for the parent domain.
   5. Enter the preferred DNS server IPv4 address, and click Next.
   6. At the Specify IPv4 WINS Server Settings screen, select WINS is not required for applications on the network, and click Next.
   7. At the Add or Edit DHCP Scopes screen, click Add.
   8. At the Add Scope screen, enter the Name DHCP Scope name.
   9. In the next box, set the following values, and click OK.
      - Start IP address=172.16.2.1
      - End IP address=172.16.100.200
      - Subnet mask=255.255.0.0
   10. Check Activate This Scope.
   11. At the Add or Edit DHCP Scopes screen, click Next.
   12. Click Enable DHCP v6 Stateless Mode, and click Next.
   13. Leave the default IPv6 DNS Settings, and click Next.
   14. At the Authorize DHCP server dialog box, select Use current credentials.
   15. At the Confirm Installation Selections screen, click Next. If the installation is set up correctly, a screen displays saying the DHCP server install succeeded.
   16. Click Close.

   **Setting up a VM to host the vCenter server (vCenter)**
   1. Log in to the infra1 server with the VMware vSphere client.
   2. In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
   3. Choose Custom, and click Next.
   4. Assign the name vCenter to the virtual machine, and click Next.
   5. Select infra1 as the host, and click Next.
   6. Select the appropriate storage, and click Next.
   7. Choose Virtual Machine Version 8, and click Next.
   8. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
   9. For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.
   10. Choose 8GB RAM, and click Next.
   11. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
   12. Leave the default virtual storage controller, and click Next.
   13. Keep the default virtual device node (0:0), and click Next.
15. Click Finish.
16. Right-click the vCenter VM, and click Edit settings.
17. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
18. Start the VM.

**Installing the Microsoft Windows Server 2008 R2 operating system on the VM**

1. Open a virtual machine console on vCenter.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New ➔ Apply ➔ Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
11. Install VMware Tools. For more information, see
12. Reboot.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to vCenter, and reboot when the installation prompts you.
16. Set up networking for the data network:
   a. Click Start, Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Uncheck TCP/IP (v6).
   d. Select TCP/IP (v4), and choose Properties.
   e. Set the IP address, subnet, gateway, and DNS server.
17. Join the domain.local domain.
18. Reboot the system.

**Setting up a VM to host Microsoft SQL server (SQL) for infrastructure**

1. Connect to the infra1 server via the VMware vSphere client.
2. Log in as root.
3. In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
4. Choose Custom, and click Next.
5. Assign the name SQL to the virtual machine, and click Next.
6. Select infra1 as the host, and click Next.
7. Select the appropriate storage, and click Next.
9. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
10. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
11. Choose 4 GB RAM, and click Next.
12. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.
13. Leave the default virtual storage controller, and click Next.
14. Choose to create a new virtual disk, and click Next.
15. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click Next.
16. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the VM, and choose Edit Settings.
19. Click the Resources tab, and click Memory.
20. Select Reserve all guest memory, and click OK.
22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1. Open a virtual machine console on SQL.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New→Apply→Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to SQL, and reboot when the installation prompts you.
16. Set up networking for the data network:
   - Click Start→Control Panel, right-click Network Connections, and choose Open.
   - Right-click the VM traffic NIC, and choose Properties.
   - Uncheck TCP/IP (v6).
   - Select TCP/IP (v4), and choose Properties.
   - Set the IP address, subnet, gateway, and DNS server.

Installing Microsoft SQL Server 2008 R2

1. Insert the installation media, and click OK to install .NET framework.
2. Wait for the SQL Installer to launch. On the left menu, click Installation.
3. Click New installation or add features to an existing installation. Click OK.
4. Enter the Product Key, and click Next.
5. Check the I accept the license terms checkbox, and click Next.
6. Click Install to install the Setup Support Files (required).
7. Resolve any issues displayed in the setup wizard, and click Next.
8. At the Setup Role screen, select SQL Server Feature Installation, and click Next.
10. Accept instance configuration defaults, and click Next.
11. Accept defaults for disk space requirements, and click Next.
12. Click Use the same account for all SQL Server services, select NT Authority\System, and click OK. Click Next.
13. Select Mixed Mode, and enter a password for the SA account. Click Add Current User, and click Next.
15. Review installation configuration rules check, and click Next.
16. To begin the installation, click Install.
17. At the completion screen, click Close.
18. Run Windows Update to receive all updates and security patches.

**Setting up databases for vCenter and VMware View™ Composer**

1. Log on to SQL as DOMAIN\administrator
2. From the server desktop, open Start→All Programs→Microsoft SQL Server 2008 R2→Configuration Tools→SQL Server Configuration Manager.
3. Click SQL Server Network Configuration→Protocols for MSSQLSERVER.
4. Right-click TCP/IP, and select Enabled.
5. Click SQL Services→right-click SQL Server Browser, and select Properties.
6. In the SQL Server Browser Properties, select the Services tab, change the Start mode to Automatic, and click OK. Repeat this step for the SQL Server Agent service.
7. Start the SQL Server browser service and the SQL Server Agent service.
8. From the SQL server desktop, open Start→All Programs→Microsoft SQL Server 2008 R2→Configuration Tools→SQL Server Management Studio.
9. Click Connect.
10. Select the Databases folder, right-click, and select New Database.
11. Provide the name vCenter for the new database.
12. Select the Databases folder, right-click, and select New Database.
13. Provide the name composer for the new database.
14. Click Options, change the recovery model from full to simple, and click OK.

**Setting up an ODBC DSN on vCenter**

1. Log in to vCenter as DOMAIN\administrator
2. Click Options and change the recovery model from full to simple, and click OK.
3. From the desktop of the vCenter server, select Start, Run, and type odbcad32.exe. Press Enter.
4. Click the system DSN tab.
5. Click Add.
6. Click SQL Server Native Client 10.0, and click Finish.
7. In the Create a New Data Source to SQL Server text box, type the connection name vcenter
8. For Server, select SQL, and click Next.
9. Change authentication to With SQL Server authentication using a login ID and password entered by the user, type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
10. Select Change the default database to choose vCenter from the pull-down menu, and click Next.
11. Click Finish.
12. Click Test Data Source… to confirm correct configuration.
13. Click OK to create the vCenter ODBC connection.

**Installing VMware vCenter 5.1**

1. Log on to vCenter as DOMAIN\administrator
2. From the VMware vCenter 5.1 install media, click Autorun.
3. Click Run to start the install wizard.
4. Click the Install button on the VMware vSphere 5.1 Simple Install wizard.
5. Select the Install wizard language as English, and click OK.
6. At the Install wizard welcome screen, click Next.
7. At the End User Patent Agreement, click Next.
8. Agree to the License Agreement, and click Next.
9. Enter and confirm the password you wish to use with the Administrator account for vCenter Single Sign On, and click Next.
10. Select Install a local Microsoft SQL Server 2008 R2 Express Instance, and click Next.
11. Enter and confirm the passwords for the DBA and SQL user accounts, and click Next.
12. Confirm the Fully Qualified Domain Name or IP address is correct, and click Next.
13. Check the Use network service account checkbox, and click Next.
14. Accept the default installation path, and click Next.
15. Accept the default https port, and click Next.
16. Click Install.
17. After Single Sign On completes, and vCenter Server installation begins, enter user information and a license key, and click Next.
18. Select Use an existing supported database, and select the Data Source Name (DSN) for the connection to the SQL Server: vcenter
19. Type sa as the database username, provide the password for the SA account, and click Next.
20. Select the system account for the vCenter Server service account, and click Next.
21. Keep the vCenter default ports, and click Next.
22. Select 1024 MB for the JVM memory, and click Next.
23. Click Install to finish the vCenter server installation.
24. Click Finish to exit the wizard.
25. Click Finish to exit the installer.
26. Restart the server.
27. Using the vSphere client, log in to the vCenter server as DOMAIN\administrator
28. Right-click the root of vCenter, and click New Data center.
29. Name the new data center datacenter
30. Add the infra1-3 servers to the data center.
31. Upgrade DC1, vCenter, and SQL to VMware hardware ver 10

**Setting up a VM to host VMWare View Composer**

1. Log in to the vCenter via the VMWare Web client.
2. Click the Virtual Machines tab.
4. Select Create a new virtual machine.
5. Choose Custom, and click Next.
6. Assign the name composer to the virtual machine, and click Next.
7. Select infra1 as the host, and click Next.
8. Select the appropriate storage, and click Next.
10. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
11. For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.
12. Choose 8GB RAM, and click Next.
13. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
14. Leave the default virtual storage controller, and click Next.
15. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the composer VM, and click Edit settings.
19. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
20. Start the VM.

**Installing the Microsoft Windows Server 2008 R2 operating system on the VM**
1. Open a virtual machine console on the composer VM.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New→Apply→Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
12. Reboot.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to composer, and reboot when the installation prompts you.
16. Set up networking for the data network:
   a. Click Start, Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Uncheck TCP/IP (v6).
   d. Select TCP/IP (v4), and choose Properties.
   e. Set the IP address, subnet, gateway, and DNS server.
17. Join the domain.local domain.
18. Reboot the system.

**Setting up a database and ODBC DSN for VMware View Composer**
1. Log on to the composer VM as DOMAIN\administrator
2. From the desktop of the vCenter server, select Start, Run, and type odbcad32.exe. Press Enter.
3. Click the system DSN tab.
4. Click Add.
5. Click SQL Server Native Client 10.0, and click Finish.
6. In the Create a New Data Source to SQL Server text box, type the connection name composer
7. For Server, select SQL, and click Next.
8. Change authentication to With SQL Server authentication using a login ID and password entered by the user, type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
9. Select Change the default database to:, choose composer from the pull-down menu, and click Next.
10. Click Finish.
11. Click Test Data Source... to confirm correct configuration.
12. Click OK to create the Composer ODBC connection.

**Setting up VMware Horizon View Composer 5.3**

1. Open the View 5 media folder, and run the file named VMware-viewcomposer-5.3.0
2. At the Welcome screen and the Patents screen, click Next.
3. Accept the VMware end user license agreement, and click Next.
4. Leave the Destination folder as default, and click Next.
5. In the Database information box, type composer as the source name and sa as the user name. Enter the password, and click Next.
6. Leave the default SOAP port, and click Next.
7. Click Install, and click Finish.
8. Restart the server.

**Setting up a VM to host the VMware View connection server**

1. Log in to the vCenter via the VMWare Web client.
2. Click the Virtual Machines tab.
4. Select Create a new virtual machine.
5. Choose Custom, and click Next.
6. Assign the name View to the virtual machine, and click Next.
7. Select infrastructure for the host, and click Next.
8. Select the appropriate storage, and click Next.
10. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
11. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
12. Choose 4GB RAM, and click Next.
13. Click 1 for the number of NICs, select VMXNET 3, connect to the PRIV-NET port group, and click Next.
14. Leave the default virtual storage controller, and click Next.
15. Choose to create a new virtual disk, and click Next.
14. Make the OS virtual disk size 100 GB, choose thick-provisioned lazy zeroed, specify the OS datastore on the external storage, and click Next.
15. Keep the default virtual device node (0:0), and click Next.
17. Right-click the View Connection VM, and click Edit settings.
18. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
19. Click Finish.
20. Start the VM.

**Installing the Microsoft Windows Server 2008 R2 operating system on the VM**

1. Open a virtual machine console on the View VM.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New→Apply→Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
11. Install VMware Tools. For more information, see
12. Reboot.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to View, and reboot when the installation prompts you.
16. Set up networking for the data network:
    a. Click Start, Control Panel, right-click Network Connections, and choose Open.
    b. Right-click the VM traffic NIC, and choose Properties.
    c. Uncheck TCP/IP (v6).
    d. Select TCP/IP (v4), and choose Properties.
    e. Set the IP address, subnet, gateway, and DNS server.
17. Join the VDI domain.
18. Reboot the system.

Installing the VMware View Connection Server 5.3
1. Log in to the server named View Connection.
2. Browse to VMware View installation media, and click VMware-viewconnectionserver-x86_64-5.3.0
3. Click Run.
4. At the Welcome screen, click Next.
5. Agree to the End User License Agreement, and click Next.
6. Keep the default installation directory, and click Next.
7. Select View Standard Server, and click Next.
8. At the Data Recovery screen, enter a backup password, and click Next.
9. Allow View Server to configure the Windows firewall automatically, and click Next.
10. Authorize the local administrator to administer View, and click Next.
11. Choose whether to participate in the customer experience improvement program, and click Next.
12. Complete the installation wizard to finish installing View Connection Server.
13. Click Finish.

Configuring the VMware Horizon View Connection Server
1. Open a Web browser to <view connection server FQDN>/admin
2. Log in as administrator
3. Under Licensing, click Edit License...
4. Enter a valid license serial number, and click OK.
5. Open View Configuration → Servers.
6. In the vCenter Servers tab, click Add...
7. Enter vCenter server credentials, and click Next.
8. At the View composer screen, select View Composer co-installed with vCenter Server, and click Next.
9. At the View composer domains screen, click Add...
10. Enter full domain name and user credentials.
11. At the storage screen select Reclaim VM disk space, and Enable View Storage Accelerator.
12. Change the Default host cache size to 1024 MB, and click Next.
13. At the ready to complete screen, click Finish.
Setting up a Windows 7 Enterprise (x86) ESXi base image VM

1. Log in to the vCenter via the VMWare Web client.
2. Click the Virtual Machines tab.
4. Select Create a new virtual machine.
5. Choose Custom, and click Next.
6. Assign the name View-gold, and click Next.
7. Select the c1-s8 host, and click Next.
8. Select the appropriate storage.
10. Choose Windows, choose Microsoft Windows 7 (64-bit), and click Next.
11. For CPUs, select one virtual processor socket and two core per virtual socket, and click Next.
12. Choose 1 GB RAM, and click Next.
13. Click 1 for the number of NICs, select VMXNET 3, and click Next.
14. Leave the default virtual storage controller, and click Next.
15. Choose to create a new virtual disk, and click Next.
16. Make the OS virtual disk size 24 GB, choose Thin Provision, specify the OS datastore on the external storage, and click Next.
17. Keep the default virtual device node (0:0), and click Next.
18. Click Finish.
19. Click the Resources tab, click Memory, and check the Reserve all guest memory checkbox.
20. Click the Hardware tab, CD/DVD Drive, and Connect the VM virtual CD-ROM to the Microsoft Windows 7 x64 installation disk.
21. Click OK.

Installing Windows 7 Enterprise (x86) on ESXi base image VM

1. When the installation prompts you, press any key to begin setup.
2. Enter your language preferences, and click Next.
3. Click Install.
4. Accept the license terms, and click Next.
5. Select Custom, and select the drive that will contain the OS.
6. Click Install.
7. Type user for the username, and click Next.
8. Enter no password, and click Next.
9. At the system protection screen, select Use recommended settings, and click Next.
10. Enter your time zone, and click Next.
11. Select the Work Network setting, and click Next.
13. Reboot.
14. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
15. Join the domain and restart the VM.

Installing the VMware Horizon View 5 agent

1. Browse to the VMware Horizon View 5 media, and run the VMware-viewagent file.
2. Click Run.
3. At the Welcome screen, click Next.
4. Accept the VMware end user license agreement, and click Next.
5. Select defaults, and click Next.
6. Enter the server name of the View Connection Server, and click Next.
7. Click Install.

**Configuring Regedit for QuickPrep**

1. Click Start -> Run, and type `regedit`
2. Browse to `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\vmware-viewcomposer-ga`.
3. Right-click `SkipLicenseActivation`, and click Modify...
4. Change the value from 0 to 1.
5. Shut down the machine, and take a snapshot of the final disk image.

**Deploying Virtual Desktops using VMware Horizon View.**

1. Open the View Administrator.
2. Log in as administrator
3. Under Inventory click Pools, and then click Add...
4. Select Automatic Pool, and click Next.
5. Select Dedicated, and click Next.
6. Select View Composer linked clones, and click Next.
7. Type `pool` for the pool ID and display name, and click Next.
8. Leave the pool settings as defaults, and click Next.
9. Under Naming Pattern, enter an appropriate name pattern for the pool.
10. Under Pool Sizing, type 1 for Max number of desktops and the number of spare (power on) desktops.
11. Select provision all desktops up-front, and click Next.
12. Under persistent disk, change the disk size to 2048.
13. Select Redirect disposable files to a non-persistent disk, type 4096 MB for Disk Size, and click Next.
15. Under vCenter Settings, use:
   - **Parent VM:** `<name of parent vm>`
   - **VM folder:**
   - **Host or cluster:** `/c1-s8/
   - **Resource pool:** `/c1-s8/
   - **Datastores= vDT-D , Overcommit: Aggressive`
16. Under Advanced Storage Options, select Use View Storage Accelerator (OS disk, 7 days).
17. Under Guest customization, select the following:
   - **Domain:** domain.local
   - **AD container:** CN=Computers
   - Select Use Quick Prep, and click Next.
18. Click Finish.
19. Repeat 15-18 to create four groups of 150 desktops on each of the VDT hosts/storage:
   - C1-s4, vDT-D
   - c1-s5, VDT-C
   - c1-s6, VDT-B
   - c1-s8, VDT-A
Installing the Login VSI 4 benchmark

Setting up a VM to host the Login VSI share
1. Connect to an infrastructure server via the VMware web client.
2. In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
3. Choose Custom, and click Next.
4. Assign the name VSI_share to the virtual machine, and click Next.
5. Select infra1 as the host, and click Next.
6. Select the appropriate storage, and click Next.
7. Choose Virtual Machine Version 9, and click Next.
8. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
9. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
10. Choose 4 GB RAM, and click Next.
11. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.
12. Leave the default virtual storage controller, and click Next.
13. Choose to create a new virtual disk, and click Next.
14. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click Next.
15. Keep the default virtual device node (0:0), and click Next.
16. Click Finish.
17. Right-click the VM, and choose Edit Settings.
18. Click the Resources tab, and click Memory.
19. Select Reserve all guest memory, and click OK.
21. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open a virtual machine console on VSIshare.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New → Apply → Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to VSISHare, and reboot when the installation prompts you.
16. Set up networking for the data network:
   a. Click Start → Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Uncheck TCP/IP (v6).
   d. Select TCP/IP (v4), and choose Properties.
e. Set the IP address, subnet, gateway, and DNS server.

**Installing the Login VSI benchmark on VSI_share**

1. Log in to VSI_Share.
2. Create a folder named c:\share
3. Right-click the c:\share folder, and click Properties.
4. Click the Sharing tab, and click Share...
5. Add everyone, system, and administrators to the Read/Write group, and click Share.
6. Unpack the Login VSI install media.
7. Open Datacenter setup\setup.exe.
8. At the welcome screen, click Next.
9. Select the share named \vsishare\share, and click Next.
10. Check the Start Login VSI Management Console checkbox to start the Management Console when the setup is completed, and click Finish.
11. At the management console enter the path to your login VSI license file and click save.

**Configuring Login VSI: AD setup**

1. Open the VSI management console and click “1. AD setup”
2. Enter the following
   - **Base OU**: DC=domain,DC=local
   - **Username**: LoginVSI
   - **Password1**: ********
   - **Domain**: (auto detect checked)
   - **Number of users**: 600
   - **Formatting length**: 1
   - **Launcher user**: Launcher-v4
   - **Launcher password**: ********
   - Click save to .sp1
3. Copy the VSIADSetup.ps1 file to \DC1\c$
4. Login to DC1, and execute the VSIADSetup.ps1 in Windows PowerShell™.

**Creating Windows 7 Enterprise x64 image VSI Launchers**

Using the vSphere client, we created a Windows 7 Enterprise x64 VM with 2 vCPUs and 12 GB of memory.

**Installing VMware View Client on the launcher**

1. Accept the VMware license terms.
2. Select default options.
3. Accept or change the destination folder.
4. Click on Install.

**Installing Virtual Audio Cable**

By default, the virtual launchers cannot render audio, so we installed Virtual Audio Cable version 4.10 from [software.muzychenko.net/eng/vac.htm](http://software.muzychenko.net/eng/vac.htm).

1. Download and extract the media.
2. Click Setup.
3. Click Yes to begin the install.
4. Click I accept to accept the software license agreement.
5. Click Install.
Installing Login VSI target software on the launcher
1. Browse to VSIinstall media\setups\Launcher\.
2. Run setup.exe.
3. In the Target Setup wizard, specify the VSI share.
4. Click Start.
5. Reboot the system.
6. Shut down the launcher VM.

Converting the launcher VM to a template
1. In vSphere Client, right-click the launcher VM, and select Template→Convert to Template.

Deploying the launchers VM from the launcher template
1. In vSphere Client, browse to Home→VMs and Templates.
2. Right-click the launcher template to deploy a virtual machine from the template.
3. Type launcher_1 as the new VM name, and click Next.
4. Click Datacenter, and click Next.
5. Click on the launcher server, and click Next.
6. Select the appropriate storage, and click Next.
7. Select customization using existing customization specifications, select the appropriate file, and click Next.
8. Click Finish to deploy the new VM.
9. Repeat steps 1 through 8 to deploy more launchers.

Configuring VSI Launchers for testing
After all 24 launchers are configured and in an idle state, configure the login VSI test harness to add them to available launcher capacity.
1. Log on to VSIShare as DOMAIN\administrator
2. Open the Login VSI management console.
3. Click “2. Add Launchers”
4. At the Add launchers wizard, click Next.
5. Click batch entry and enter the following:

   Name=launcher
   Start number=1
   Increment=1
   Count=24
   Maximum capacity=30
   Formatting length=2

6. Click Next.
7. Click Finish.

Running the Login VSI benchmark
Before we ran our test, we executed assign_user.ps1 on the VMWare view server and statically assigned login_VSI users to virtual desktops so persona data would not be created randomly in testing. Next, we ran a profile create job in Login VSI to fully initialize each user’s profile. Finally, we used twenty-four launchers to run a medium
workload with a launch interval of 20 seconds in benchmarking mode. See Appendix C for detailed settings use. For more information on how to run a Login VSI test, see www.loginvsi.com/documentation/index.php?title=Main_Page.

**Setting up DVD Store database VMs**

We set up four Server 2012 VMs, each with 4 vCPUs and 12 GB of RAM. We installed and configured them with Microsoft Windows Server 2012 and Microsoft SQL Server 2012.

**Setting up the virtual machine**

1. Connect to vCenter via the VMware vSphere Web client.
2. Click the Virtual Machines tab.
4. Choose Custom, and click Next.
5. Enter the name of the virtual machine, and click Next.
6. Select the first host, and click Next.
7. Select the first LUN for the storage, and click Next.
9. Choose Windows, choose Microsoft Windows Server 2012 (64-bit), and click Next.
10. For CPUs, select one virtual processor socket, with four cores per virtual socket, and click Next.
11. Choose 64GB RAM, and click Next.
12. Click 1 for the number of NICs, select VMXNET3, connect to the vSwitch0 network, and click Next.
13. Leave the default virtual storage controller, and click Next.
14. Choose to Create a new virtual disk, and click Next.
15. Set the OS virtual disk size to 85GB, choose thick-provisioned lazy-zeroed, specify the OS datastore on the external storage, and click Next.
16. Keep the default virtual device node (0:0), and click Next.
17. Click Finish.
18. Right-click the VM, and choose Edit Settings.
19. Click the Resources tab, and click Memory.
20. Select reserve all guest memory, and click OK.
22. Start the VM.

**Installing the VM operating system on the first SQL VM**

1. At the Language Selection Screen, click Next.
2. Click Install Now.
3. Select Windows Server 2012 Enterprise (Full Installation), and click Next.
4. Click the I accept the license terms checkbox, and click Next.
5. Click Custom.
6. Click Next.
7. At the User’s password must be changed before logging on warning screen, click OK.
8. Enter the desired password for the administrator in both fields, and click the arrow to continue.
9. At the Your password has been changed screen, click OK.
10. Install the latest Host Integration Tools package on the VM. Restart as necessary.
11. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
12. Enable remote desktop access.
13. Change the hostname, and reboot when prompted.
14. Create a shared folder to store test script files. Set permissions as needed.
15. Set up networking:
   a. Click Start→Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
c. Select TCP/IP (v4), and choose Properties.
d. Assign the VM a static IP address.

16. Shut down the VM.
17. Clone the VM three times.

**Installing and configuring Microsoft SQL Server 2012**

We installed Microsoft SQL Server 2012 on the VMs residing on the systems under test.

**Configuring the SQL Server VM**

After cloning, modify the SQL VM to contain two additional virtual disks:

- 130 GB virtual disks for SQL database (Thick provisioned, eager-zeroed)

In the VM, configure the VM storage:

1. In the taskbar, click the Server Manager icon.
2. In the left pane, expand Storage, and click Disk Management.
3. Right-click the first volume, and choose Initialize Disk.
4. In the right pane, right-click the volume, and choose New Simple Volume...
5. At the welcome window, click Next.
6. At the Specify Volume Size window, leave the default selection, and click Next.
7. At the Assign Drive Letter or Path window, choose the appropriate drive letters for E:\ and I:\, and click Next.
8. At the Format Partition window, choose NTFS, and click Next.
9. At the Completing the New Simple Volume Wizard window, click Finish.

**Installing Microsoft SQL Server 2012**

1. Open the console for the VM or connect to the VM with RDP.
2. Mount the installation ISO to the VM.
3. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and double-click.
4. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
5. In the left pane, click Installation.
6. Click New SQL Server stand-alone installation or add features to an existing installation.
7. At the Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant warnings, click OK.
8. Select the Specify a free edition from the drop-down menu, and select Evaluation. Click Next.
9. Click the checkbox to accept the license terms, and click Next.
10. If no failures are displayed after the setup support files are installed, click Next.
11. At the Setup Role screen, choose SQL Server Feature Installation.
13. At the Installation Rules screen, click Next after the check completes.
14. At the Instance configuration screen, leave the default selection of default instance, and click Next.
15. At the Disk Space Requirements screen, click Next.
16. At the Server Configuration screen, check that NT AUTHORITY\SYSTEM is selected for SQL Server Agent and SQL Server Database Engine. Click Next.
17. Assuming there are no failures, click Next.
18. At the Database Engine Configuration screen, select Mixed Mode.
19. Enter and confirm a password for the system administrator account.
20. Click Add Current user. This may take several seconds.
21. Click the Data Directories tab, and enter the appropriate drive and folders for database and logs.
22. Click Next.
23. At the Error and usage reporting screen, click Next.
24. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click Next.
25. At the Ready to Install screen, click Install.
27. Create a SQL Server login for the ds2user (see the Configuring the database (Data generation overview) section for the specific script to use).
28. Copy the pre-created DVD Store backup to the specified backup volume.
29. Download and install any available updates for Microsoft SQL Server 2012. We installed SQL Server 2012 SP1 and CU5.

**Configuring the database workload client**

For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed Windows Server 2008 R2, assigned a static IP address, and installed .NET 3.5.

**Configuring the database**

**Data generation overview**

For each Database VM, we generated data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the parameters for our 20GB database size and the database platform on which we ran Microsoft SQL Server. We ran the Install.pl script on a utility system running Linux. The Install.pl script also generated the database schema.

After processing the data generation, we transferred the data files and schema creation files to a Windows-based system running SQL Server 2012. We built the 20GB database in SQL Server 2012, and then performed a full backup, storing the backup file for quick access. We used that backup file to restore the server between test runs.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the test. Besides this file size modification, the database schema was created and loaded according to the DVD Store documentation. Specifically, we followed these steps:

1. We generated the data and created the database and file structure using database creation scripts in the DS2 download. We made size modifications specific to our 20GB database and the appropriate changes to drive letters.
2. We transferred the files from our Linux data generation system to a Windows system running SQL Server.
3. We created database tables, stored procedures, and objects using the provided DVD Store scripts.
4. We set the database recovery model to bulk-logged to prevent excess logging.
5. We loaded the data we generated into the database. For data loading, we used the import wizard in SQL Server Management Studio. Where necessary, we retained options from the original scripts, such as Enable Identity Insert.
6. We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
7. We updated statistics on each table according to database-creation scripts, which sample 18 percent of the table data.
8. On the SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL) script:

```sql
USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'",
```
9. We set the database recovery model back to full.
10. We created the necessary full text index using SQL Server Management Studio.
11. We created a database user and mapped this user to the SQL Server login.

We then performed a full backup of the database. This backup allowed us to restore the databases to a pristine state relatively quickly between tests. Figure 52 shows our initial file size modifications.

<table>
<thead>
<tr>
<th>Logical name</th>
<th>Filegroup</th>
<th>Initial size (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>primary</td>
<td>PRIMARY</td>
<td>3.25</td>
</tr>
<tr>
<td>cust1</td>
<td>DS_CUST_FG</td>
<td>5,767</td>
</tr>
<tr>
<td>cust2</td>
<td>DS_CUST_FG</td>
<td>5,767</td>
</tr>
<tr>
<td>ind1</td>
<td>DS_IND_FG</td>
<td>2,621</td>
</tr>
<tr>
<td>ind2</td>
<td>DS_IND_FG</td>
<td>2,621</td>
</tr>
<tr>
<td>ds_misc</td>
<td>DS_MISC_FG</td>
<td>2,621</td>
</tr>
<tr>
<td>orders1</td>
<td>DS_ORDERS</td>
<td>2,621</td>
</tr>
<tr>
<td>orders2</td>
<td>DS_ORDERS</td>
<td>2,621</td>
</tr>
</tbody>
</table>
| ds_log       | Not Applicable | 20,480         

Figure 52: Our initial file size modifications.

**Configuring the database workload client**

For our testing, we used two client machines. To create these clients (DVDS-C1 and DVDS-C2), we installed Windows Server 2012 on two VMs. Each VM was created with 2 vCPUs and 8 GB of RAM. We installed .NET 3.5. on each.

**Installing and configuring Microsoft LoadGen**

**Creating an Exchange server VM**

1. Connect to vCenter via the VMware vSphere Web client.
2. Click the Virtual Machines tab.
4. Choose Custom, and click Next.
5. Assign a name to the virtual machine, and click Next.
6. Select the Microsoft Exchange Datastore on the external storage, and click Next.
7. Choose Virtual Machine Version 9, and click Next.
8. Choose Windows, select Microsoft Windows Server 2012 (64-bit), and click Next.
9. Choose 1 virtual socket, and 4 virtual processors per core, and click Next.
10. Choose 4GB RAM, and click Next.
11. Click 1 for the number of NICs, select vmxnet3, and click Next.
12. Leave the default virtual storage controller, and click Next.
13. Choose to create a new virtual disk, and click Next.
14. Make the virtual disk size 90 GB, and choose thick-provisioned lazy zeroed.
15. Keep the default virtual device node (0:0), and click Next.
16. Click Finish.
17. Right click the VM, select Upgrade Virtual Hardware, and click Yes.
18. Start the VM.
19. Attach the Windows Server 2012 ISO image to the VM, and install Windows Server 2012 on your VM.

Installing the operating system on the exchange client the VM

See the above sections regarding the initial creation of the virtual machines. We provide steps below for installing the operating system.

Installing the VM operating system on the VM

1. Connect to the ISO image of the installation DVD for Windows Server 2012 Enterprise from the VM console. If the ISO image is not stored on the host, start the VM first and then connect to the ISO image.
2. Start the VM.
3. At the Language Selection Screen, click Next.
4. Click Install Now.
5. Select Windows Server 2012 Enterprise (Full Installation), and click Next.
6. Click the I accept the license terms checkbox, and click Next.
7. Click Custom.
8. Click Next.
9. At the User’s password must be changed before logging on warning screen, click OK.
10. Enter the desired password for the administrator in both fields, and click the arrow to continue.
11. At the Your password has been changed screen, click OK.
12. Install the latest VMware Tools package on the VM. Restart as necessary.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Change the hostname and reboot when prompted.
15. Create a shared folder to store test script files. Set permissions as needed.
16. Set up networking:
   a. Click Start→Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Select TCP/IP (v4), and choose Properties.
   d. Set the IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server traffic. Click OK, and click Close.

Installing and configuring Microsoft Exchange Server

We cloned our exchange VM three times on server c1-s7 and then joined each to the domain.local domain. We installed Microsoft Exchange 2010 SP3 on each of the four Exchange VMs.
Configuring the Exchange 2010 VM

1. Power on the machine.
2. Select Start → Control Panel → Network Connections → Ethernet.
3. Click Properties.
4. Highlight Internet Protocol (TCP/IP), and click Properties.
5. Select the Use the following IP address radio button, and enter the desired IP for your testing network.
6. Select the Use the following DNS server addresses radio button, and enter the IP of the AD server in the Preferred DNS server field. Click OK.
7. Right-click My Computer, and select Properties.
8. Under the Computer Name tab, click Change.
9. In the Computer Name Changes screen, under Computer name, type exc01
10. In the Computer Name Changes screen, under the Member of section, select the Domain radio button, and type domain.local
11. To start joining the domain, select OK.
12. When the screen appears asking for a person qualified on the domain, type administrator as the username and the password.
13. At the Welcome pop-up and the window warning that you must restart the computer for the changes to take effect, click OK.
14. At the System Properties screen, click OK.
15. When a pop-up appears asking if you want to restart now, click Yes to restart your machine.

Installing .NET Framework 3.5.1 Features and Internet Information Services

1. Select Start → Administrative Tools → Server Manager.
2. Click Features.
3. Click Add Features.
4. Select .NET Framework 3.5.1 Features.
5. Click Add Required Role Services.
6. Click Next.
7. Click Next.
8. At the Select Role Services screen, click the checkboxes for IIS 6 Metabase Compatibility, IIS 6 Management Console, Basic Authentication, Windows Authentication, Digest Authentication, Static content compression, and Dynamic content Compression, and click Next.
9. At the Confirm Installation Selections screen, click Install.
10. At the Installation Results screen, click Close.

Installing Microsoft Filter Pack

2. Run FilterPackx64.exe.
3. Click Next.
4. Click I accept the terms in the License Agreement, and click Next.
5. When the installation is complete, click OK.
Installing Exchange Server

1. Click Start, type services.msc and press Enter.
2. Right-click the Net.Tcp Port Sharing service, and click Properties.
3. Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
4. Open command prompt, type ServerManagerCmd -i RSAT-ADDS and press Enter.
5. Reboot the VM.
6. Mount the installation ISO to the VM and click Setup.exe when prompted.
7. The installer should consider steps 1 and 2 complete, and gray them out.
8. Click the link for Step 3: Choose Exchange Language Option.
9. Click Install only languages from the DVD.
10. Click the link for Step 4: Install Microsoft Exchange Server 2010 SP1.
11. To go past the introduction screen, click Next.
12. Accept the license agreement, and click Next.
13. Select No for error reporting, and click Next.
15. Leave the organization name as the default (First Organization), and click Next.
16. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
17. Click Next to accept defaults for Configure Client Access server external domain.
18. At the Customer Experience Improvement Program screen, select I don’t want to join the program at this time, and click Next.
19. If a warning about a lack of SMTP appears after the check finishes, ignore it.
20. To start the installation process, click Install.
21. Once installation is complete, click Finish.
22. Click OK when prompted to reboot.
23. Click Close.
24. To confirm closing, click Yes.
25. Reboot the VM.

Installing SP3 for Microsoft Exchange 2010

2. To extract the installation files, double-click the downloaded file.
3. To accept the destination directory for the extracted files, click OK.
4. To launch the installer, double-click setup.exe.
5. Click Install Microsoft Exchange Server upgrade.
6. At the Introduction screen, click Next.
7. Accept the terms in the license agreement, and click Next. The Readiness Checks should begin.
8. Install any roles in Server Manager that the Readiness Checks prompt you to install.
9. When the checks successfully complete, click Upgrade.
10. Click Finish, and reboot the VM.
Configuring Exchange Server 2010 connector

1. In the VM, Select Start → All Programs → Microsoft Exchange Server 2010 → Exchange Management Console.
2. In the left pane, click Microsoft Exchange On-Premises.
3. In the left pane, expand Organization Configuration, and select Hub Transport.
4. In the action pane on the far right, select New Send Connector.
5. Name the send connector SMTP, select the intended use as Internet, and click Next.
6. In the Address space screen, click Add.
7. In the SMTP Address Space screen, type * as the address, ensure that the installer has checked Include all subdomains, and click OK.
8. Click Next.
9. To accept defaults for the next two pages, click Next.
10. At the New Connector page, click New to create the connector.
11. To close the New SMTP Send Connector wizard, click Finish.

Configuring the Exchange Server 2010 Mailbox role

2. In the left pane, expand Organization Configuration, and click Mailbox.
3. Click the Database Management tab.
4. Right-click Mailbox Database, and select Properties.
5. Select the Maintenance tab.
6. Check the Enable circular logging box.
7. Check the box beside This database can be overwritten by a restore.
8. Next to Maintenance interval, click Customize.
9. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
10. Click OK.
11. Click OK to any warnings about circular logging being applied after the database is remounted.
12. On the far right pane, click Move Databases.
13. Change the Database file and Log folder path locations to point to the two additional attached virtual disks, and click Move.
14. If the application prompts you to dismount, click Yes.
15. Click Finish.
16. Right-click Public Folder Database, and select Properties.
17. Check the Enable circular logging checkbox, and uncheck the ESE scanning checkbox.
18. Next to Maintenance interval, click Customize.
19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
20. Click OK.
21. On any warnings about circular logging being applied after the database is remounted, click OK.
22. On the far right pane, click Move Database.
23. Change the Database file and Log folder path locations to point to the two additional attached virtual disks respectively, and click Move.
24. If the application prompts you to dismount, click Yes.
25. Click Finish.
Installing and configuring the Exchange 2010 mail test client (LGC01)

For our testing, we used a virtual client for the LoadGen workload. To create this client, we installed Windows Server 2012 on a VM with 1 vCPU and 4 GB of RAM.

Join LGC01 to the domain

1. Log on to LGC01.
2. Select Start ➔ Control Panel ➔ Network Connections ➔ Local Area Connection.
3. Click Properties.
4. Highlight Internet Protocol (TCP/IP), and click Properties.
5. Select the Use the following IP address radio button, and enter the desired IP for your VM.
6. Select the Use the following DNS server addresses radio button, and enter the IP of the AD server in the Preferred DNS server field. Click OK.
7. Right-click My Computer, and select Properties.
8. Under the Computer Name tab, click Change.
9. In the Computer Name Changes screen, under Computer name, type lgc01 as your computer name.
10. In the Computer Name Changes screen, under the Member of section, select the Domain radio button. Type domain.local and select OK.
11. When the screen appears asking for a person qualified on the domain, type administrator as the username and the admin password.
12. At the Welcome pop-up and the window warning that you must reset the computer for the changes to take effect, click OK.
13. At the System Properties screen, click OK.
14. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services

1. When LGC01 reboots, log in as DOMAIN\administrator
2. Click Start ➔ Administrative Tools ➔ Server Manager.
3. On the left pane, click Roles.
4. Click Add Roles.
5. Click the Application Server checkbox.
6. When the Add features required for Application Server? screen appears, click Add Required Features.
7. Click Next.
8. Click Next.
9. At the Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.
10. Click Add Required Support Role Services.
11. Click Next.
12. Click Next.
13. At the Select Role Services page for Web Server (IIS), click IIS 6 Management Compatibility, ASP, and CGI checkboxes; and click Next.
14. Click Install.
15. Click Close.
Installing Load Generator 2010

1. Download and install Load Generator 2010 using all defaults.

Preparing Load Generator

1. Log in to the mail client using the tester account.
2. Select Start→All Programs→Microsoft Exchange→Exchange Load Generator 2010.
3. When the Load Generator screen appears, select Start a new test.
4. Select Create a new test configuration, and click Continue.
5. Change the total length of simulation to 90 minutes.
6. In the Specify test settings screen, type the password for Directory Access Password and Mailbox Account Master Password, and click Continue with recipient management.
7. Make 400 users in the Mailbox Database, and click Continue.
8. To accept defaults for Advanced recipient settings, click Continue.
9. In the Specify test user groups screen, select the plus sign to add a user group.
10. Change the Client Type to Outlook 2007 Cached, the Action Profile to Exchange_200, and the Mailbox size to 250 MB.
11. In Remote configurations, click Continue.
12. Click Save the configuration file as, and name it testcfg.xml
13. After saving the configuration file, click Start the initialization phase (recommended before running the test).
APPENDIX C – METHODOLOGY FOR ADDITIONAL PROCEDURES

Deploying the ioSphere VM

We took the following steps to deploy the ioSphere VM:
1. Download the appliance.
2. Start the vSphere client and log in to vCenter as a vSphere admin.
3. From the vSphere client, click File > Deploy OVF Template and choose the iosphere-vme.ova from step 1.
4. Accept the licensing agreement, and click Next.
5. Select the data center, and click Next.
6. Select the infrastructure host, and click Next.
7. Select the storage (NAS01).
8. Select thick provisioned lazy zeroed, and click Next.
9. Select the priv-net network, and click Next.
10. Enter the password, gateway, and DNS addresses, and click Next.
11. Click power on after deployment, and click Finish.

Configuring the ioSphere VM

We took the following steps to configure the ioSphere VM:
1. In vSphere client, open a KVM session to the ioSphere VM.
2. Set the time zone.
3. Note the management IP address.
4. Close the KVM.
5. Open a browser to https://<address from step 3>

Installing host drivers and configuring ioTurbine

We took the following steps to install the host drivers and configure ioTurbine.
1. Copy the following files to /vmfs/volumes/DAS:
   - libvsl-1.0.0-vsl.3.2.6.1219.zip
   - fio_iot_offline_bundle_esx50.zip
   - scsi-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
   - block-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
2. From the ESXi command line, run:
   - esxcli software vib install -d/vmfs/volumes/DAS/fio_iot_offline_bundle_esx50.zip
   - esxcli software vib install -d/vmfs/volumes/DAS/libvsl-1.0.0-vsl.3.2.6.1219.zip
   - esxcli software vib install -d/vmfs/volumes/DAS/scsi-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
   - esxcli software vib install -d/vmfs/volumes/DAS/block-iomemory-vsl-5X-3.2.6.1219-offline_bundle-1377628.zip
3. Reboot the appliance.
4. In vCenter, host c1-s7 now has a Fusion ioSphere tab. Select it, and click the adaptor on the left. Select low-level format.
## APPENDIX D – DETAILED VIRTUAL MACHINE CONFIGURATION

Figure 53 shows the detailed information of the virtual machine we used in testing.

<table>
<thead>
<tr>
<th>VM name</th>
<th>Qty</th>
<th>OS</th>
<th>Role</th>
<th>Host(s)</th>
<th>LUN</th>
<th>vCPUs</th>
<th>Mem (GB)</th>
<th>vDisk (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC1</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>Active Directory, DNS, DHCP</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>4</td>
<td>100</td>
</tr>
<tr>
<td>VSI_Share</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>Login VSI share</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>2</td>
<td>100</td>
</tr>
<tr>
<td>ioSphere VM</td>
<td>1</td>
<td>Virtual appliance</td>
<td>Fusion-io IO mgmt server</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>4</td>
<td>60</td>
</tr>
<tr>
<td>vCenter</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>VMware vCenter</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>8</td>
<td>100</td>
</tr>
<tr>
<td>Composer</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>VMware Composer</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>2</td>
<td>100</td>
</tr>
<tr>
<td>View</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>VMware View server</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>4</td>
<td>100</td>
</tr>
<tr>
<td>SQL</td>
<td>1</td>
<td>Windows 2008 R2</td>
<td>vCenter, and Composer DB server</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>4</td>
<td>100</td>
</tr>
<tr>
<td>L01-l24</td>
<td>24</td>
<td>Windows 7 (x64)</td>
<td>Login VSI Launcher</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>8</td>
<td>40</td>
</tr>
<tr>
<td>LGC01</td>
<td>1</td>
<td>Windows Server 2012</td>
<td>Exchange client</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>1</td>
<td>4</td>
<td>40</td>
</tr>
<tr>
<td>DVDS-C1,2</td>
<td>2</td>
<td>Windows Server 2012</td>
<td>OLTP clients</td>
<td>Infra1-3</td>
<td>NAS01</td>
<td>2</td>
<td>4</td>
<td>40</td>
</tr>
<tr>
<td>View001-600</td>
<td>600</td>
<td>Windows 7 (x86)</td>
<td>VMware Virtual Desktop</td>
<td>c1-s5-8</td>
<td>VDT A-D</td>
<td>1</td>
<td>1</td>
<td>24</td>
</tr>
<tr>
<td>SQL01-04</td>
<td>4</td>
<td>Windows Server 2012</td>
<td>OLTP, SQL server</td>
<td>c1-s4</td>
<td>DVD-SQL</td>
<td>4</td>
<td>12</td>
<td>130</td>
</tr>
<tr>
<td>EXC01-04</td>
<td>4</td>
<td>Windows Server 2012</td>
<td>LoadGen Exchange server</td>
<td>c1-s4</td>
<td>Exchange</td>
<td>4</td>
<td>4</td>
<td>90</td>
</tr>
</tbody>
</table>

*Figure 53: Detailed information for our virtual machines.*
APPENDIX E – LOGIN VSI FILES

VSILauncher.ini

[Scenario]
CPUEnabled=enabled
NumberOfCPU=8
CoresEnabled=enabled
NumberOfCores=64
HyperThreadingEnabled=enabled
HostsEnabled=enabled
NumberOfHosts=4

[Launcher]
BaselinePhase=1
Servername=
Username=
Password=enc:BD177557C81239CEC1:enc
ShowPassword=C0403E14874E
Domain=
useCSV=1

CCL="C:\Program Files\VMware\VMware View\Client\bin\wswc.exe" -serverURL
view -username %csv_username% -password ******** -domainName domain-
desktopName pool -standAlone -logInAsCurrentUser False -nonInteractive#

CSV=\\vsishare\share\ccl.csv
PhasesCount=1
NumberOfSessions=600
SequentialInterval=4
AutoLogoff=1
LogoffTimeOut=300
CreateProfile=0
TSDiscon=0
PreTestScript=
PostTestScript=
BaseLinePhaseSessions=5
BaseLinePhaseSamples=5
BaselineSampleInterval=3
BaseLinePhaseInterval=6
BaselinePhaseTotalTime=105
Fancy_Number=0
[VS1]
SkipAddLaunchersScreen=0
SkipCommandLineScreen=0
SkipStartTestScreen=0
[Phase1]
Name=Benchmarking Phase
Sessions=600
PhaseTime=2880
Pause=False
[LauncherWorkload]
launcherUsername=domain\launcher
launcherPassword=enc:BD177557C81239CEC1:enc
launcherWorkflow=0
limitConcurrent=10
launcherResolution=1024x768
launcherDisconnectAfterLaunch=0
[Phase2]

*Global.ini*

[Logon]
ImportOfficeReg=1
CopyPST=1
MapUserHome=1
MapGroupDrive=1
SetFreemindFTA=1
EngineStartup=Shell
[Settings]
Workload_Language=English
Office_version=14
Office_Language=English
office_print_sequence={altdown}fpp{altup}
Engine_Debug=0
Workload_Debug=0
PDFPrinting=1
Pause={Pause}
Workload_Loops=99999
Logoff_Action=shutdown /l
UserHome=H:
Groupdrive=G:
LogoffAt=segment
SegmentsPerFile=20
RandomInitialWait=5
log_category_AppStart=True
log_category_LoopTimer=False
log_category_RandomCopy=False
log_category_SegmentTimer=False
IEVersion=Auto
IEVideoOption=Auto
winwait_timeout=120
winwaitactive_timeout=120
timer_timeout=60
logout_on_fatal_error=1
Workload=medium
Benchmark_Mode=1

[GUI]
Fancy=0
Mode=Compact
Assign_user.psl
$Maxrun = 600
for($i = 1; $i -le $Maxrun; $i++)
{
vdmadmin -L -d pool -m vdt-$i.ToString("000") -u domain\LoginVSI$i
}
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc. All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.